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ABOUT THIS DOCUMENT

The Owner's Manual for the XPS 16K and XPS 16KD can be downloaded from the XPS product page That document
gives a basic overview of the XPS amplifier hardware, its installation and front panel operation.

This Applications Guide is intended to give operators a deeper and more thorough understanding of how to configure
and operate the XPS amplifier for field applications, including control and programming via RDNet, plus a sprinkling
of helpful tips to aid your workflow.

The latest release can be downloaded from the XPS product pages.

Throughout the document, you will find Tip boxes like this one, which contain field application tips and
workflow suggestions for XPS specifically developed by our application support team.



https://www.rcf.it/en/products/product-detail/XPS%2016K#downloads
https://www.rcf.it/en/xps-series?utm_source=soundlite.it

PHYSICAL OVERVIEW

For a full physical overview and tour of the XPS amplifier hardware, see the Owner’s Manual, downloadable from the
XPS product page.

REAR BRACKETS

The XPS amplifier ships with a set of rear brackets to support the rear of the unit when it is mounted in the rack. These
are required due to the weight and depth of the unit, to prevent accidental falls that could cause damages to the
amplifier itself or other gear in the same rack.

REAR PANEL

A full overview of the rear panel connections, complete with pinouts, is available in the Owner's Manual document
downloadable from the XPS product page.

Analog and AES/EBU Inputs
INPUTS

Both XPS variants (16K and 16KD) offer four (4) XLR p
inputs for analog and digital signals. The first two XLR |@@
jacks (labeled A1 and A2 for Analog 1 and Analog 2),

always accept balanced, line level analog signals. The ®
following two XLR inputs can be configured to accept =
either two additonal analog signals (A3 and A4), or two
pairs of AES/EBU digital signals (D1/2 on jack 3, and D3/4

on jack 4.). ——Pin 1
Pin 3
The digital inputs can be enabled or disabled in RDNet L Pin2

software, or via the front panel of the amplifier.

When the digital inputs are disabled, all four XLR inputs can accept analog input signals that are made available in the
Routing configuration as A1 thru A4.

When the digital inputs are enabled, the first two analog inputs (A1 and A2) remain available, along with Digital inputs
D1 thru D4.

Thus, an XPS will make available for routing either up to (4) analog input signals at once with the digital inputs
disabled, or up to (2) analog signals and (4) AES/EBU signals at once with the digital inputs enabled.

AES/EBU Link Outputs

The two AES/EBU LINK XLR outputs on the rear panel provide outgoing digital AES/EBU signals that can drive
additional XPS amplifiers or other devices. The behavior of these outputs depends on the state of the Direct Mode
setting:


https://www.rcf.it/en/products/product-detail/xps-16k#downloads
https://www.rcf.it/en/products/product-detail/xps-16k#downloads

Direct Mode

With Direct Mode off, the user can select any of the available input signals to be routed to each digital output (any of
the Analog, Digital AES/EBU, and, in the case of the XPS 16KD, inputs from the Dante network.

This allows an XPS amplifier to be used as an AES/EBU “on ramp,” with the first amplifier in a chain converting analog
signals to AES/EBU which can then be daisy chained to additional amplifiers.

Of course, this introduces a small amount of latency (0.7 ms) due to the conversion, so it is not recommended when
the XPS amplifier in question needs to have its outputs perfectly time aligned with additional XPS amplifiers in the
chain. For example, if it is one of multiple XPS units powering a line array.

Also, it is important to note that in this mode, no signal is sent to the digital outputs when the XPS is in Standby.

With Direct Mode enabled, the Link output jacks have fixed routing, directly connecting digital inputs 1-4 to outputs
1-4. This is traditional “link” or cascade behavior, with the digital signals passed directly between input and output
with no delay or latency.

The AES/EBU signal is actively regenerated by the amplifier to avoid signal loss or degradation with large numbers of
daisy chain links. This routing persists when the XPS is in Standby.

When the amplifier has no power supply, digital inputs 1-4 are directly connected to digital outputs 1-4 via a hardware
relay bypass. The chart below shows all possible states for the digital outputs depending on power status and Direct
Mode setting:

DIRECT MODE OFF DIRECT MODE ON
User-selected inputs Fixed AES routing
Power On routed to each digital output (Inputs 1-4 to Outputs 1-4)
0.7 ms latency no latency
Fixed AES routing
Standby No signal sent to digital outputs (Inputs 1-4 to Outputs 1-4)
no latency

Fixed Routing (AES/EBU Inputs 1-4 to Outputs 1-4)

No Power Supply Relay Bypass, no latency



POWER AND STANDBY

MAINS VOLTAGE

The XPS amplifier can accept a mains operating voltage between 90 and 240V AC at 50 or 60 Hz. However, for optimal
performance, mains voltage of at least 208V is strongly recommended. Although the amplifier will operate at 120V,
it will exhibit reduced performance, particularly when driving high current demand loudspeakers such as GTS 29 and
GTX 12.

PD 30A VOLTAGE SELECTION

When powering the XPS amplifiers via the PD 30A power distribution module, be sure to rotate the voltage selection
switch on the rear of the PD 30A to designate whether the amplifiers should receive 120V (line-neutral) or 208V (line-
line) mains voltage. As stated above, 208V is highly recommended particularly for high-performance applications.



NETWORK CONNECTIONS

The XPS 16K features four (4) Gigabit Ethernet network
ports, managed by an internal network switch compliant
with |EEE802.1 AVB standard. LAN 1 and LAN 2 are
standard RJ45 ports, while LAN 3 and LAN 4 support
locking EtherCON connectors. Any of the LAN ports can be
used to connect to the control network.

RDNET OVER ETHERNET

XPS amplifiers can communicate directly with RDNet via
standard [P traffic so an RDNet control interface
(CONTROL8 or CONTROL2) is not required as it would be
for self-powered RCF products.

Simply connect the amplifiers to the same network as the
computer running RDNet, with compatible IP addresses
and subnet masks.

DAISY CHAIN TOPOLOGY

Thanks to the internal switch, multiple XPS amplifiers can
be connected in a daisy chain topology.

The Ethernet ports and internal switch remain active when
the amplifier is connected to mains power, so
communication with units further down the chain will not
be lost when the XPS is in standby. However, it is not
recommended to connect more than eight (8) units in a
daisy chain.

STAR TOPOLOGY

A star topology can be implemented by connecting each
XPS unit directly to a network switch. In this configuration,
a power loss to one unit will not disrupt control network
communication with any other unit.

If the external network switch is managed and supports STP
(Spanning Tree Protocol), full control network redundancy
can be achieved by connecting two (2) different network
ports of the XPS to the network switch. Full control network
redundancy is probably not required in most applications,
since a network connection interruption simply means a
loss of the ability to control and monitor the XPS amplifiers,
but would not interrupt audio.

LAN1
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o

LAN2

ETHERNET INTERFACE

RDNet over ethernet
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HYBRID TOPOLOGY

Perhaps the most common and effective amplifier control network topology is a hybrid topology, which combines the
star and daisy chain approaches shown above. Typically, each rack of amplifiers would have a dedicated connection
to the network switch, and then network connection is passed between the amplifiers in each rack via a daisy chain.

This approach is a functional compromise between cabling efficiency and control robustness for most applications.

SWITCH

m s@ s@ @ s :@ s@ @ @ g@B_ RDNet over ethernet

DANTE CARD (XPS 16KD ONLY)

On XPS 16KD units, the LAN 1 and LAN 2 ports function exactly as described in the previous section. The LAN3 and
LAN4 are instead replaced by Dante Primary and Secondary ports.

The Dante module can be set to Switched or Redundant modes, although Redundant is highly recommended so a
single network connection failure will not interrupt audio. Please refer to Audinate documentation for information on

Dante network topology and switch configurations.

Additionally, if the Dante network is configured as Switched, it is strongly recommended not to exceed 3 XPS units
connected in daisy chain.

Note: It is strongly recommended to keep Dante and RDNet control traffic separated into two different VLANS.
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RDNET WORKFLOW

Basic front panel operations are covered in the XPS owner’s guide. In practice, for most applications, once the front
panel has been used to configure the network settings of the XPS units in the system, RDNet will be a faster and more
efficient way of programming and controlling the amplifiers rather than making adjustments directly on the front panel.

Although this guide is not intended to replace a full RDNet training, we will cover some of the commonly used functions
relevant to working with XPS amplifiers and GTX series loudspeakers.

LAUNCHING THE PROGRAM

Once RDNet is installed, two executables can be found in Program Files (x86) > RCF > RDNet 5: one called RDNet.exe
and one called RDNetLauncher.exe.

Launching RDNetLauncher.exe brings up the RDNet splash screen. If the program detects an active internet connection
at this point, it will phone home to Italy and politely inquire as to the latest version of RDNet software. If an update is
available, it will notify you and allow you to download the update directly from the splash.

Since RDNet 5 incorporates cloud features (more on that later), you will be prompted to enter your RDNet account
information the first time you launch the program.

Tip: This prompt will only appear if the program detects an active internet connection, so if you are in a hurry
and don’t remember your login credentials, simply disable your WiFi adapter and relaunch the program to
suppress the login prompt. Of course, you will not be able to use any of the cloud features until you decide to
log in.

You can also skip all the above hullaballoo and bypass the launcher entirely by directly launching RDNet5.exe.

NETWORK INTERFACE SELECTION

If you have just installed, or updated, RDNet, it may not have a network adapter selected by default, and so be unable
to see any CONTROL 8 or XPS on the network. You can confirm which network adapter(s) are enabled for use by
clicking Options in the menu bar at the top of the RDNet window, then clicking the Settings cog.

In the Network tab, RDNet displays a list of all the detected network adapters, their IP addresses, and which are set
to Active. Make sure the Active toggle is enabled for the desired network adapter, and that its IP address is properly
configured in the same range as the amplifiers.

Tip: If your network adapter doesnt show up in this list, you may need to restart RDNet or restart your
computer, as a network adapter driver crash may have occurred. This is @ more common issue for users running
RDNet via a virtual machine.
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CONTROLLERS PANEL

XPS amplifiers show up in RDNet in the Controllers panel (if you previously hid this and are now realizing the error of
your ways, you can get it back by clicking Tools > Controllers.)

RDNet is constantly scanning
the network and detecting p——
XPS amplifiers. Each XPS e
detected is displayed as a
rectangular tile listing the
Name of the amplifier, its IP
address, its ID (a long
numerical string that is mostly
meaningless to mere humans), and a timestamp at the bottom, which indicates the timestamp the XPS amplifier was
last seen on the network. To add an amplifier to the project, simply drag and drop its tile into an empty spot in the 2D
view workspace. A synchronization window will pop up as RDNet communicates with the amplifier, and once it has
been successfully brought into the project, the tile will display a bright green bar along the left side of the tile in the
Controllers panel.

E Controllers X

Order By

These amplifiers are “claimed” by your project and will not show up in the Controllers panel of any other instances of
RDNet running on the same network. Any unmatched amplifiers — without the green bar — will show up in other
instances of the program and are available to be matched into other designs by other RDNet instances running on the
same network.

For example, one XPS amplifier could be matched into a different RDNet project on a different computer, by a monitor
engineer using the XPS to drive a sidefill system on stage, while the FOH engineer matches other XPS amplifiers with
the main PA system.

When working with larger quantities of XPS amplifiers, you can click the icon in the upper left corner of the Controllers
panel to display in List format, then click “IP" to sort the list by IP address, which greatly streamlines the process of
locating the proper amplifier in the list.

Tip: We recommend carefully choosing IP addresses for each amplifier so you can keep track of the physical
location of each unit. For example, you might start addressing your Stage Left amplifiers as .101, .102, .103,
etc. and your stage right amplifiers as .201, .202, .203, etc. That way you can tell which physical amplifier
you're dealing with just by looking at the IP address in the Controllers screen. Since the amplifier names can
change based on the RDNet file programming, a systematic static IP address scheme is the most reliable method
to keep track of which physical amplifier corresponds to which tile in the software.

BUILD AS YOU GO WORKFLOW

For basic projects with a small quantity of XPS amplifiers, a “build as you go” workflow can be used, in which the XPS
amplifiers are added to a blank RDNet project and configured online in real time.

Simply drag and drop amplifier tiles from the Controllers panel into the 2D view. You can also multi-select several
amplifiers and click “Add Selected Devices” at the top of the Controllers panel to add them to the workspace all at
once.
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PROJECT DESIGN WORKFLOW

For larger, more complex projects involving multiple XPS amplifiers, a Project Design workflow is probably preferable.
In this workflow, an entire project file is created using “virtual” XPS amplifiers, loudspeakers added and assigned to
amplifiers, and amplifier parameters are set as desired, then the virtual amplifier configurations are matched with
physical amplifiers. This workflow also has the added benefit of allowing you to build the entire file ahead of time, i.e.,
an active connection to the system is not required. An RDNet design can be prepared in advance and then quickly
synchronized to the amplifiers on site.

Virtual XPS amplifiers can be added to the workspace using the Tools > Add Objects popup. Simply select the XPS
amplifier in the menu and drag it into the workspace. You will be prompted to choose the number of amplifiers you
want to add. Then simply work as normal (described below).

To synchronize to physical amplifiers, drag an amplifier tile from the Controllers panel and drop it directly onto a virtual
amplifier that's already in the workspace. A pop-up window will be displayed as the amplifier settings in the design
file are pushed to the physical amplifier.

SYNCHRONIZATION STATE

The synchronization state of an XPS amplifier is indicated by the
color of the center screen on the RDNet object icon.

- When the amplifier is properly and fully synchronized, the
center screen will be green.

- If synchronization is not fully successful or is interrupted, the center screen on the icon will be yellow. A yellow
exclamation point symbol displayed on the amplifier icon also indicates a partial synchronization state.

- A red center screen on the icon indicates a unit fault or error. See the front panel of the XPS amplifier for
details.

- Unmatched amplifier objects are black (no color) on the central screen.

You can synchronize all amplifiers in the project at once by clicking the Synchronize symbol in the
upper right corner of the RDNet window. This will push all XPS settings in the RDNet project into the
matched amplifiers. You can also synchronize a single amplifier, or a multi-selected group of amplifiers,
by right-clicking on the amplifier object and clicking Synchronize from the drop-down menu.

Synchronize

Sometimes an amplifier might be feeling particularly stubborn and will not show “all green” even after you ask it to
synchronize, in which case you can force-feed it the proper parameters by right-clicking the unit and choosing Force
Device Configuration from the drop-down menu.

ADDING OBJECTS

When you start a new RDNet file, the Add Objects panel will automatically be open. This is where you'll select the XPS
amplifiers and loudspeaker objects that will be used in your file. If you previously closed the Add Objects panel and are
now regretting that decision, you can get it back by clicking Tools > Add Objects in the top menu bar.

13



Typically, it is best to start by adding the loudspeaker objects first. For example, your PA system might include 12 boxes
per side of GTX 10 and three GTS 29 subwoofers per side. Start by locating the GTX 10 in the Add Objects panel. You
can quickly filter down the results by typing “GTX" into the search bar, which will show you only loudspeaker models
with “GTX" in the name.

Tip: the search bar filters through results in real time, so typing “G" is sufficient to remove from view all
products whose names don't start with G. This is much faster than scrolling through the long list of loudspeaker
objects.

Once you've located the GTX 10 loudspeaker, drag and drop it into the DEVICE SETTINGS - GTX 10
workspace to add it to your project. When you do, a Device Settings | defout +
dialog will pop up and ask you to choose the number of items. 1

In this case, it is asking not for the total number of loudspeakers, but
how many amplifier zones we want. For example, if we're driving the
GTX 10 in 4 zones of 3 boxes per side, we would set the Number field Ganeel
to 8.

This adds 8 GTX 10 loudspeaker objects to the space — we should arrange them to visually represent the physical
arrangement of loudspeakers in the system — four in the left array, and four on the right.

Tip: Adding all 8 zones at once creates a single vertical column of loudspeaker objects. You will then want to
select the bottom four and move them sideways to represent the other side of the PA. You may instead find it
faster to add (4) objects, then drag and drop another GTX 10 object from the Add Objects panel and drop it
alongside the first array. The Number field will automatically remember the last number you entered, so you
can add another array of the same size quickly.

Next, we need to tell RDNet how many loudspeakers are in each amplifier zone — one, two, or three. In this case, all
four of our zones have three loudspeakers, so we will click the small [+] button along the bottom of the loudspeaker
object twice until it displays (3).

Tip: Increasing the number of loudspeaker elements per amplifier zone increases the vertical size of the
loudspeaker object icon and ruins your beautifully spaced layout. You can quickly rearrange the loudspeaker
objects into properly spaced vertical columns by selecting the stack and clicking View > Device Arrange in the
top menu bar. Do this separately for each array.

Next, add the GTS 29 subwoofers in the same way — by dragging them from the Add Objects panel — and arrange
them as desired in the workspace to visually represent their physical configuration. GTS 29 subwoofers are drive one
subwoofer per amplifier channel, so there’s no need to click the [+] to add subwoofers to the amplifier zone — in fact,
RDNet won't let you do it.

Finally, we need to add the XPS amplifiers themselves. For the purposes of this example, we will assume we're working
offline and add virtual XPS objects from the Add Objects panel, but you can also work online by directly adding the
detected physical XPS amplifiers from the Controllers panel.

14



Naming XPS Amplifiers

Once you have added the appropriate number of amplifiers, we will be responsible, organized system designers and
label our amplifiers. This helps us keep track of them in the project, and more importantly, will cause the amplifier's
name to be displayed on the front panel display of each unit once we synchronize the design with the physical
amplifiers.

Right-click on the amplifier icon and choose Rename Device from the drop-down menu, type your desired name and
hit Enter. The amplifier name is now displayed in the yellow bar in in the lower left corner of the amplifier icon.

Once the amplifier has been matched and synchronized to a physical amplifier, hovering your mouse cursor over the
amplifier icon will instead display its IP address.

ASSIGNING LOUDSPEAKERS TO XPS AMPLIFIERS

Now that we have loudspeakers and amplifiers in our project, we need to tell RDNet which loudspeakers are connected
to which amplifiers. We can again do this with a simple drag-and-drop operation:

Click and drag the grey [+] icon at the top left of each loudspeaker object and drop it onto the amplifier you want to
pair it with. The XPS icon will then color in the four circles across the bottom of the icon — these indicate the four
output channels of the amplifier, labeled A, B, C and D. Color coding is used to indicate the number of amp channels
used per loudspeaker object. When you assign a GTX 10 object to an amplifier, you will notice that A and B both turn
purple, since the GTX 10 is driven with 2 amplifier channels.

Dragging another zone of GTX 10 to the same XPS amplifier will automatically assign that GTX 10 zone to amplifier
outputs C and D, and they will turn blue.

When assigning GTS 29 subwoofers, each subwoofer takes up a single amplifier channel, and so each channel output
circle icon will turn a different color. Conversely, GTX 12 occupies all four amplifier output channels, and all four output
circles will turn the same purple color.

The loudspeaker icons will also display the name of the amplifier they are assigned to in the lower left corner of the
loudspeaker icon. Hovering your mouse cursor over the loudspeaker icon will instead display the name of the
loudspeaker model.

Tip: You can visually confirm which loudspeaker objects are connected to an amp channel by clicking and
holding on the colored circle on the amplifier icon. RDNet will display a color-coded line from the amplifier
channel to the assigned loudspeaker object.

If you are doing this loudspeaker-to-amplifier matching process while online and synchronized with the physical
amplifiers, you will notice that each time you make an assignment, the Synchronization dialog pops up while the data
is sent to the amplifier. If you have many amplifiers in your design, this can slow you down quite a bit. This is an
additional advantage of building the file “offline” with the virtual XPS objects, then using drag-and-drop matching
from the Controllers panel onto the virtual amplifiers. In this way, the synchronization process only happens once per
amplifier.

15



SELECTING LOUDSPEAKER PRESETS

Some loudspeakers have user-configurable preset options. For example, the GTS 29 [T
subwoofer has several low pass filter options, including 50 Hz, 60 Hz, 80 Hz, 100 Hz, and 2

additional cardioid presets for each. You can make your preset selections as a batch 60
operation by selecting some or all of the subwoofer icons and clicking the up-down arrows .
to scroll through the low pass filter options in the Properties tab that pops out from the
right side of the screen.

In a new RDNet project, the Properties panel will auto-expand when one or more object icons are selected in the
workspace. If you previously closed it, you can get it back by clicking Tools > Properties in the top menu bar.

The options and parameters available in the Properties panel will vary depending on what type of object is selected,
but it is the fastest way to quickly implement parameter changes across multiple objects in RDNet.

GROUPS AND ARRAYS

Groups

Another way to work with groups of objects in RDNet is to add them to a Group. For example, we now have 6
subwoofers in our project. We can set the EQ and other processing parameters for each subwoofer by clicking on the
EQ button on its icon, but that is unwieldy with a large number of subwoofers, and usually we want to EQ the entire
subwoofer array at once.

To add the subwoofers to a group, multi-select them all, then right-click on any selected subwoofer icon, and from the
drop-down menu that appears, choose Assign To Group > and then choose one of the lettered groups to add the
subwoofers to. The MUTE buttons on each icon will then change to GMUTE, indicating that the mute now acts as a
group mute and will mute / unmute all objects in the group at once. Similarly, any changes made in the EQ / processing
screen will be applied to all the members of the group.

You can open the Groups panel by clicking Tools > Groups in the top menu bar. Here you can assign a unique name
and color to each group. The loudspeaker objects that are members of that group will inherit the group color in the
2D view.

Tip: When trying to move quickly, the group letter can be used as shorthand for the group name, for example,
using Group F for front fills or Group S for subwoofers, leaving yourself a “breadcrumb” that allows you to
quickly go through and name all your groups at once.

Arrays

In RDNet, the Array function is like a Group but with some extra abilities, all of which are specifically tailored to
optimizing the behavior of line arrays. Specially, adding line array-type loudspeakers to an Array enables the Bass
Shaper tool for line length compensation in the low and low-mid frequency ranges, enables FIRphase high frequency
filtering, allowing the array to be divided into up to 5 zones for more granular high frequency shading control, and
enables air compensation filters.

16



Low Frequency Cluster Size Correction

The low frequency correction tool has a default setting of 2.2, which is
an unaltered LF response. Increasing the LF correction value results in
a low- and low-mid reduction designed to counteract the LF pool-up
that occurs naturally as the result of flying a high number of cabinets
together in a line array. Decreasing the value below 2.2 will result in a
gentle low-frequency boost, designed to help shorter arrays with fewer
elements better tonally match with longer ones. Although the Venue
tool will generate a starting point low frequency correction value for
each array, it can be easily adjusted to “season to taste” and quickly
change the low frequency response of the system.

FIRphase High Frequency Shading

Solo

Each cabinet in a line array, or each amplifier zone of
cabinets in the case of arrays driven by XPS, can be assigned ||l e
to one of five zones that can be individually EQ'd with the | Zone3 @ 00
high frequency FIRphase filters. These assignments are | Zoned @A 00
made by clicking the colored squares labeled 1 through 5 at B

the bottom of each array element’s 2D view icon.

-2.2

LOCAL ZONE - FIRPhase Gain

Air Compensation filters
The air compensation filters can be individually adjusted per array element, or per amplifier zone in the case of arrays
driven by XPS amplifiers.

The default setting is 1 (no boost), and increasing the value will add high frequency emphasis to the response of that
cabinet (or amplifier zone) intended to counteract the natural absorption of high frequency energy over distance
through the air.

The Venue tool generates starting point values for HF compensation, which can be adjusted to taste and based on
atmospheric conditions.
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XPS PARAMETERS IN PROPERTIES PANEL

Properties v X

MUTE

(0] Auto On | Enable

Screen

Lock
Priority Input

Signal

e Enable

The Properties panel is also extremely useful for making parameter changes to one or more selected XPS amplifiers.

The power icon in the upper left corner mirrors the functionality of the power icon located on the amplifier object icon
in the workspace, and toggles the amplifier power state between On (yellow) and Standby (grey).

Standby and Auto-On

Auto On determines the behavior of the amplifier whenever it is connected to mains voltage. With Auto On disabled,
the amplifier will stay in Standby mode (red front panel LED) when it is connected to power. In this Standby state, the
network interface and DSP modules are still powered up, so programming via RDNet can still be carried out.

With Auto on set to Enabled, the amplifier will fully boot into On state when it is connected to mains power.

Tone Generator

The Tone Generator is a handy way to verify loudspeaker cabling is correct without needing an external input source
connected to the XPS amplifiers. To begin, ensure that all output channels of all amplifiers are muted (you can click
Mute All in the upper right corner of the RDNet window to do this quickly).

Next, select the amplifier(s) you wish to activate the signal generators for, set the Gain control to an appropriate and
non-scary level (such as -42 dB), choose the signal type — either Pink noise (PINK) or a sine wave (SIN), and click the
green Enable button, which will turn red to indicate that the generator is active. Clicking the button again will disable
the signal generator and turn the button green again.

Then you can selectively mute and unmute one loudspeaker zone at a time by selecting the desired zone and using the
Properties panel Mute button to override the GMUTE group mute behavior to verify the system cabling is correct.

Tip: Take care to type the negative sign before your desired generator signal level (-42, not just 42) to avoid a
mishap. RDNet will not assume that entered dB values are negative.
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XPS CONFIGURATION

Double-clicking on an XPS object in RDNet's main 2D view will open a pop-up dialog with multiple tabs containing
XPS configuration options.

PHYSICAL IN/OUT

On the Physical IN/OUT tab, we have the & 20 - o X

basic input and output settings for the XPS Digital Inputs
unit. The Digital Inputs AES/EBU button [REEEE AES/EBU

will enable or disable the AES/EBU inputs [l

Load Monitor

on the rear of the amplifier. When this Rl N

Settings

Input

function is set to “Off,” all four XLR jacks
on the rear of the amplifier will accept

Tone Generator

analog line-level signals. When it is set to Gain Signal o Freq f@
On, XLR jacks 3 and 4 will each accept a “ ( e e (NS I g;,]
pair of AES/EBU digital signals. See T - 2 03 o4

Analog and AES/EBU Inputs on page 6 for Al v Al ~

more information.

Priority Input designates an input as the priority override input for the GPIO “Input Override” functionality, often used
to give an input precedent in evacuation emergencies, etc.

Below that are the Tone Generator controls, described in 7one Generatoron page 18.

Signal Outputs controls the behavior of the AES/EBU outputs on the rear of the amplifier. With Direct Mode enabled,
they are simple link-throughs of the AES/EBU input jacks directly above them. With Direct Mode off, you can choose
which analog or network (Dante) signals should be routed to those outputs. See AES/EBU Link Outputs on page 6 for
details.

ROUTING

The Routing tab allows you to choose [®=2 -9
which of the available input signals Ve lnest e VIR iy ProT TONE o
should drive each connected loudspeaker [t FORCEMAN ~ % 180° e
object. The number of choices t0 have 10 [l EEa NI ckp G Backup ;
make here depends on the configuration [ = =

of the loudspeaker that is being driven by -

the XPS. A GTX 12, for example, uses all vemiont "IN oy PrOT TONE Notch

four amplifier channels, so you'll be able D2 v FORCEMAN v % 80’ & e T

to select a single Main Input and Backup — o Ty et U

Polarity

Input to drive the GTX 12. If you connect
four GTS 29, each of which consume only
a single amplifier channel, you'll be able to select individual Main and Backup inputs for each output channel.

= 180°
2 0.0

Select A1-A4 to choose an Analog input source, D1-D4 to choose a Digital (AES-EBU) input source, and, in the case
of the XPS 16KD, N1-N8 to choose a Network (Dante) input source.
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In this example, two zones of GTX 10 are being driven by this XPS (one zone on output channels A/B, and the other
on output channels C/D). Therefore, we can select inputs for the AB zone, and another set of inputs for the CD zone.

In this example, the first AES input (D1) has been selected for the AB zone's main input, while D2 will drive the CD
zone. Once an input source is selected, the metering bar to the right will display the incoming signal level.

Selecting a Backup Input is optional, but it can be used to specify a “fallback” analog input in the case that the AES
signal fails. This can also be used to sum two signals together to drive the connected loudspeaker.

The Routing Mode dropdown selects the behavior of the two input signals:

- Force Mainwill cause the amplifier to use only the Main Input signal.

- Force Backup will use only the selected Backup Input.

- Mixed will sum both the Main and Backup input signals together (useful for mono-summing L and R into a
subwoofer).

- Pilot Tone will look for a pilot sine wave tone on the Main Input and fall back to the Backup Input in the case
that the pilot tone is no longer detected. The pilot tone configuration settings are to the right (Gate and Notch
Filter controls).

- AES Presence will fall back to the Backup Input if the AES clock signal is no longer detected on the Main Input.
This option is only available with an AES signal is selected as the Main Input. Similarly, Dante Presence will be
added as a routing mode in a future firmware update.

You can also adjust gains independently for the Main and Backup inputs using the gain controls — helpful for when
there is a level difference between the incoming digital and analog signals — as well as invert the polarity of either
input.

Tip: To configure the XPS 16KD amplifier in a dual redundant Dante plus manually activated Analog Backup
configuration as may be typically deployed as part of a touring production system, select the Network input as
Main, and the Analog backup input as Backup, and set the Routing Mode control to MIXED. The amplifier will
now “listen” to both incoming Dante and Analog backup signals. The analog signal is kept muted in the front-
end processor, and if both Primary and Secondary Dante networks fail, the operator can simply unmute the
analog drive lines in the system’s front end processor.

SCENES MANAGEMENT

The XPS has an internal scene library which allows the user to save and load up to 31 scenes to quickly change the
unit between various configuration states. These scenes can also be recalled via GPIO, and the first eight (8) scenes
can also be recalled via OSC.

LOAD MONITOR

The XPS has rudimentary load monitoring capabilities, which measure the impedance of the connected load with the
loudspeaker on “idle” state (cool and muted) and then monitor the deviation from that calibration value over time.

To start, click the Enable button on the output channel you wish you monitor, and then click Calibrate. The amplifier
will take a few seconds to measure the impedance of the connected load. Adjust the Tolerance High and Tolerance
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Low dials to set the allowable tolerance — we recommend 30% as a starting value. It is recommended to perform the
calibration routine with the connected loudspeaker muted and at ambient temperature for best results.

GPIO CONFIGURATION

XPS features General Purpose Input and Output (GPIO) contacts to be connected to other systems such as voice
announce and alarm systems.

See the XPS 16K Owner's Manual for more information on GPIO and OSC configuration parameters.

SETTINGS

The Settings tab allows adjustment of a variety of parameters. Device Name can be set here (however, it's much quicker
to do this directly from the 2D view using the right click menu). Auto On can be selected, but again, this is faster to as
a batch operation for multiple units using the Properties panel.

Screen Lock does exactly what it says — prevents users from making changes to the XPS configuration via the front
panel display.

Network Settings allow you to set an IP and Gateway for the amplifier plus enable DHCP, with the obvious caveat that
you have to be connected to the amplifier via IP control in order to adjust these settings. For this reason, these settings
will likely be done via the unit's front panel display, at least initially.

Remote are advanced settings relating to RDNet port and OSC control. Please contact RCF support for assistance with
these settings if needed, as setting them incorrectly can lead to unexpected behaviors.

At the bottom of this tab, you can view the current Firmware and Library revisions for the device, as well as what
Libraries are contained in the unit. See Libraries on page 25 for details.
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ADVANCED FUNCTIONALITY

RDNET FUNCTIONS

RDNet allows the use of assignable Functions to apply special
parameters to a group of objects. For example, you could use a
Function to apply a gain reduction to a few cabinets out of an Name: Bottom Box Courey
Array group, or extra delay to a few subwoofers that are all
controlled by a subwoofers Group.

Multi-select the objects you wish to add to a function, then
choose Functions > New > Master.

If the Functions panel is not already opened, it will automatically
open, with a new function that is automatically named Master 0 he L)
or something equally mysterious. Rename it right away to prevent
any confusion.

You now have Gain, Delay, and Polarity controls for these objects that apply /7 addition tothe controls in the EQ screen
for the object itself or the Group or Array it may be a member of.

Click the List icon in the upper right of the function module to pop out a list displaying all the objects that are members
of that function. Click the Power icon to disable the function.

Note: there are multiple types of Functions in RDNet, our discussion here is limited to the Master function. See the
RDNet user documentation for more info on the other Function types.

Tip: Closing the Function box itself, using the X symbol in the upper right corner, will delete the function and
release those DSP parameter changes, not simply hide the function from view. If you want to hide it, close the
Functions panel. You can get it back via Tools > Functions.

QSYS INTEGRATION

A QSYS plugin is available for XPS amplifiers. Please contact RCF support for details.
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UPDATING FIRMWARE AND LIBRARIES

When a new XPS unit is unboxed and powered on for the first time, it will likely require a firmware update and libraries
update to function properly. Additionally, library and firmware updates will be released from time to time to improve
the functionality of the unit.

The first step in updating the firmware and libraries of the XPS amplifier is to configure the network settings of the
amplifier so RDNet software can connect to and communicate with the XPS unit.

XPS NETWORK CONFIGURATION

The XPS amplifier is its own RDNet controller, but in order to connect to the XPS via RDNet, the computer running
RDNet and the amplifier must be on the same IP network. Although you may be able to successfully rely on the dynamic,
self-assigned IP address (169.254.X.X), it is strongly recommended to set static IP addresses for both the XPS amplifiers
and the computer being used to connect, particularly when multiple XPS units are being used.

This is because the name of the amplifier can be freely assigned by, and changed by, the RDNet configuration that is
loaded into the amplifiers, so if both the name and the IP address can change dynamically, you may have trouble telling
which physical unit corresponds to which network object you see in the software. Pushing the wrong loudspeaker
preset to the wrong amplifier could have catastrophic consequences for the connected loudspeakers.

For this reason, we strongly recommend assigning static IP address to each XPS amplifier and then physically labeling
each amplifier with its corresponding IP address.

This way, if the unit needs to be factory reset for any reason, you will know what its IP should be and be able to quickly

reconfigure the unit to appear back on the network as it was [

before NETWORK SETTINGS

DHCP ON OFF
To set a Static IP address on XPS, press the Menu button on the [y 169.25452.1
front panel of the unit, scroll down using the encoder to Network
Settings, and either tap the entry or click the encoder to select the
entry. Gateway address 0.0.00

Subnet mask 255.255.00

MAC address d41c:1¢:32:1:33

On this screen, set DHCP to Off. Then click EDIT in the IP address
field. Hold Bksp to clear the existing entry, and enter the Static IP address you wish to assign (for example,
192.168.1.101) then click OK. For Subnet Mask, enter 255.255.255.0.

Note: Programming and deploying XPS amplifiers requires a basic working knowledge of IP network configurations,
which is beyond the scope of this document. A popular resource for this topic is /ntroduction to Show Networking by
John Huntington.
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WINDOWS NETWORK CONFIGURATION

Open the Windows Start Menu and start typing View Network Connections, and select View Network Connections
from the search results. Click Change Adapter Settings, then right-click the network adapter you're using for RDNet
and choose Properties.

In the Properties dialog, click Internet Protocol Version 4, then click the Properties button to open the IP field.

Click Use the following IP address: and enter the desired address (for example, 192.168.1.100). Use the same subnet
mask that you used for the XPS amplifier. Then click OK.

You can verify the computer’s active network adapter and current IP address by opening the Run dialog (Windows Key
+ R) and typing cmd then pressing Enter to open a command prompt. You can also open a terminal window by right-
clicking on the Start menu and choosing Terminal.

Once there, type jpconfig and press Enter to ask the computer to list its current network adapter information.

CONNECTING TO THE XPS AMPLIFIER

To ensure you have the most current version of firmware for your XPS, it is important to make sure your RDNet 5
software is up to date. Launching the RDNetLauncher executable while your computer is connected to the internet
will automatically check for RDNet updates. If an update is available, a message on the splash screen will notify you.

In RDNet, click Tools in the top menu bar, then choose Controllers to open the Controllers panel. If you properly
configured your network settings, the XPS amplifier should be detected automatically and displayed as a tile in this
panel.

If an XPS unit appears in the Controllers panel with a purple outline, this is an indicator that the firmware version of
the XPS does not match the current firmware version in RDNet, and you will only be able to connect to the XPS amplifier
for the purposes of updating its firmware.

If an XPS unit appears in the Controllers panel shaded red, this is an indication that the libraries | E—_G_G..
stored inside the XPS unit are outdated compared to the current libraries version in RDNet, and a

Library Update procedure is required (see below). @ )

Tip. If you are working with large quantities of XPS, you can click the tiles icon in the upper left corner of the Controllers
panel to display the amplifier list as a table.

To connect to the XPS amplifier, simply click its tile and drag it into the 2D workspace.

When you release, a dialog will appear as RDNet goes “online” with the XPS.
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CHECKING CURRENT FIRMWARE VERSION

If you want to check which firmware [@a ' ’ - o0 x
version your XPS is running, double-click | e

Routing . ;‘;"- XPS Auto On | 'Enable

the XPS object in RDNet to open its |RSuuu—"—
configuration dialog. Choose Settings [ —"

from the left menu, and FW Revision will [ § e e

GPIO Configur:

0.0.0.0 Gateway 0.0.0.0

be displayed at the bottom of the dialog. Reload

You can also check XPS firmware
version from the front panel of the :
amplifier. Press the Menu button on the > ooas : oo

Remote
port 9090

0.0.0.0

front panel and use the encoder to scroll 4 0000 0000
down to System Info and press to e —

select. On the General tab, you can see
Firmware ver. displayed.

7 0000

Fw Re

FIRMWARE UPDATE PROCEDURE

Once you have connected to an XPS amplifier using RDNet, if a firmware update is available, a red arrow icon will be
displayed over the XPS object icon in the 2D workspace.

1. Initiate the firmware update process by clicking the XPS object to select it (note: you can perform the firmware
update procedure on multiple XPS amplifiers at the same time by multi-selecting them).

2. Click Advanced in the top menu and choose Firmware Update from the toolbar.

3. From the droplist that appears, choose XPS or Active Device.

4. From the file browser that appears, scroll down to the folder named XPS16K and double-click to open the
folder.

5. Click to select the single .RDU file inside the folder, and then click Open.

6. A dialog box appears, displaying the firmware r
version you're about to send, and the current | ROFRONet X
firmware version. Once you are ready to continue, Al

. Current Rev. 18

click Ok. Continue?

7. A popup window will appear as the firmware file
is sent to the amplifiers. Once it is successfully
sent, a message will notify you.

8. The amplifier will run its update procedure, and upon completion it will power itself down. Once the amplifier
is in its standby stage (Power LED = red), press and hold to re-power the amplifier.

9. Reconnect to the amplifier in RDNet by dragging and dropping it from the Controllers panel onto its
corresponding object in the 2D view.

LIBRARIES

The XPS amplifier does not ship with loudspeaker libraries uploaded to the unit. As such, it can be customized to
contain whichever libraries are necessary for the application. There are two ways to manage XPS libraries via RDNet:
Library Update, and Library Create / Send.

Library Update will update all the loudspeaker libraries to the current version for loudspeaker presets that are already
loaded into the XPS amplifier.
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If your XPS does not yet contain any libraries for the loudspeaker models you need, you must first send those libraries
to the amplifier (Library Create / Send).

Library Update

1. Once connected to the XPS, select it (or multiple) in the 2D view and then click Advanced in the top menu
bar.
2. Select Libraries Update and confirm to update the libraries.

Library Create / Send

To send preset libraries for new loudspeaker models to the XPS, use the Library Manager feature. IMPORTANT: Make
sure you are on the most current Firmware version before sending libraries (See Updating XPS Firmware).

1. Once connected to the XPS, select it (or multiple) in the 2D view and then click Advanced in the top menu
bar.

2. Click Library Manager, and choose Create from the droplist that appears.

3. From the window that appears, check the box next to each loudspeaker model you'd like to include in the XPS
device library, or click Select All to send everything.

4. Once you have made all your selections, click Save. In the file browser that appears, choose a memorable and

easy-to-access location to save the generated library file, then click OK. RDNet will generate and save a file

named “lib.zip" in the directory you chose.

Select all XPS amplifier objects that you wish to send the library to in the 2D view.

Click again on Library Manager, and this time choose Send.

Browse to the lip.zip file you saved in step 4, and choose OK.

RDNet will display a pop up letting you know that you're about to push a library containing the listed

loudspeaker models to the selected amplifiers. Confirm to continue.

9. The amplifiers will run their library update procedure and display the progress on the front panel displays.
Once they are done, they may go to Standby mode or turn themselves back on depending on the state of the
Auto On setting.

10. Reconnect the XPS to their corresponding objects in the 2D view by dragging and dropping the detected
amplifiers from the Controllers panel.

oW

DANTE FIRMWARE UPDATE PROCEDURE (XPS 16KD ONLY)

RDNet allows you to manage the Dante configuration of the XPS 16KD Dante card directly through the amplifier
properties dialog in RDNet. A firmware update of the Dante module may be required to achieve this.

The required firmware update files, as well as a PDF with written documentation of the update procedure, can be
found in the RDNet program directory at Program Files (x86) > RCF > RDNet > FirmwareUpgrade > XPS16K.
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TROUBLESHOOTING

Virtually every issue with XPS that can be resolved by the end user can be resolved in one of two ways:

1. Following the Firmware update, Library Create / Send and Library Update procedures detailed in this guide
(see Firmware Update Procedure and Libraries).

2. Performing a full factory reset via the front panel menu, then reassigning the proper IP address and re-synching
the amplifier with RDNet.

If neither of these procedures resolves the issue, please contact RCF USA support.

ERROR CODES

The following table provides a description of all possible XPS error codes reported by the amplifier. If you need to
contact RCF USA support about an error code, please take note of which one is being displayed.

Code  Description ‘

2 Warning condition detected, fail-safe protection strategy active
5 Generic error

6 Service, driver or peripheral internal error.

7 Operation timed out

8 Service, device or peripheral busy, retry later.

9 Parameter out of bounds

10-11 | System Software Exception

12 Data transfer or communication error

13 Too much data (buffer overrun)

14 Missing data (buffer underrun)

15 Stream, file or connection open failed

16 Stream, file or connection close failed

17 Read or receive error

18 Write or send error

19 Upper memory or queue limit reached
20 Data mismatch or component compatibility verification failed
21 Memory allocation failed

22 Peripheral, device or task setup failed

23 Checksum verification failed
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